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Printers, Fonts,
and Documents
ALEC MULVEY

For many, the misunderstood  relationship between printer drivers,
fonts, and documents means trial and error with every document.
But it doesn’t have to be that way, as veteran Q&A consultant Alec
Mulvey shows.

MANY people experience difficulty using fonts in Q&A for DOS. For
some unknown reason, their documents and reports always print
in Courier, or their columns are neatly aligned on the screen but

go to pot when printed, or they�re forever adjusting their Define Page
screen settings and still getting unpredictable results.

The fact is, you probably can make use of the fonts in your modern
printer, and you can align columns and adjust page margins for consistent
output�but not using Q&A�s default settings.

It helps to understand the rationale behind the settings you need to
make to get the kind of output you need, so I�ll show you how to use
proportionally-spaced fonts in Write documents, Print Specs, Reports�in
whatever method you use to print from Q&A.

Fonts in general
The fonts you can use in your Q&A documents depend on the fonts your
printer supports, whether they�re built into the printer, on font cartridges,
or soft fonts downloaded to the printer.

Until you properly install and apply your fonts, Q&A will use your
printer�s default font, probably fixed-pitch Courier.

To succeed with fonts, you must set up Q&A properly�a process that
includes the following steps:

• Installing the correct printer from the list of available printer drivers.

• Installing the correct font file for the printer.

• Using absolute measurements for page width and left and right margins.

• Using Q&A�s Real tab characters option.

• Assigning the fonts to the document (at least a Regular or default font).

• Assigning and applying additional fonts if you want your output to
appear in more than one font.

1.  Installing a printer driver
Q&A supports hundreds of printers, including all the most popular ones
up to 1995. You can install up to five (A through E) printers in Q&A,
though you�re actually setting up five different printer drivers. Printer
installation is a combination of the following elements:

• Printer make and model.

• Paper size.

• Paper orientation (portrait or landscape for sheet-fed printers).

• Resolution (if supported)
expressed in dpi (dots per inch) for
laser and inkjet printers, or NLQ/
Draft for dot matrix printers.

For example, printers A and B
might be portrait and landscape
drivers for the same printer. Though
the allowance of five printers might
seem generous, if you want a local
printer, and a network printer, and
each in both portrait and landscape
orientation, you�ve already used up
four of your five installable printers.
If you then want to use two paper
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Lock Your Database
(Before Somebody Else Does)

Q&A lets you lock a database to prevent others from changing

the custom features you’ve designed into it. Even if you don’t

want to restrict access to anything, you should still lock the

database. Here’s why. If the database is secured, anyone with

design rights can lock it. If it isn’t secured, anyone at all can lock

it. And once it’s locked, nobody—not even Symantec—can tell

you how to unlock it without the password. One client of mine

had his database accidentally locked by an errant macro!

Backup the database before locking it. Then, select File /

Design File / Customize Application / Lock Database, and enter

the database name. (If it’s secured, you’ll need to enter a

password with design rights.) At the Database Lock screen, type

a password in the Password field, and write it down. Set Should

the database lock be enabled? to Yes, then optionally set any

lockable elements to No. (These override any Security Spec

access rights.) Finally, press F10.

Having to enter your password and disable the lock before

you can redesign something is a small price to pay  compared to

being locked out altogether.

Erika Yoxall, Hammer Data Systems, 330-527-4018

 In the May 1997 issue (“Forms Within Forms”), a production error
dropped several lines from the top of page 3. Here’s the missing text:

. . .the note will appear on the message line. To view lengthier notes, you’ll just click on

the Note field, and press F6 to expand it. You’ll click on the down arrow button to scroll. . .

Be sure the RecordNumber field in the NOTES2 database is a number field.
In Part 2 (June issue), the last five lines in the first column on page 9 (the

NoteBar field’s program) should read:

If @Left(NoteCode, @Len(Cust ID)) <> Cust ID
Then
{ If @Askuser(“No Notes for this customer.”,“Want to add one?”,””)
Then goto NoteAdd else goto NoteBar }
Else

Oops!

WE’RE gearin� up here at The Quick Answer for the Q&A Masters
Seminar on Friday, October 24 in Savannah, Georgia. For the
third consecutive year, this day-long event (featuring the Q&A

experts you read in The Quick Answer) preceeds the Annual National
Q&A Users Group Bash. If you use Q&A for more than storing your
favorite recipes,  I urge you to attend both the Masters Seminar and the
Bash. You�ll enjoy a fun-filled, informative weekend with fellow Q&A
enthusiasts, watch a terrific mix of expert presentations on the big
screen, and get your Q&A questions answered during the workshops.
For more information on the Bash, call Gale Platt at 561-482-5604. For
details on the Masters Seminar, call 800-780-5474 or 301-424-1658.

If you�ve mastered the relationship between Q&A printer drivers,
fonts, and document settings, you know what 90 percent of Q&A for
DOS users don�t. If you�re in that majority, or you could stand a little
brush-up, Alec Mulvey takes you back to basics.

Ever wonder what, besides more records, makes your Q&A
database swell to unmanageable proportions? Why is it you can add 20
records to a database without the file size changing, then after the 21st,
the size suddenly jumps another 65K? John Dow has the answers.

Jeff Nitka is on vacation this month. He returns next month along
with his Program Spec column.
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Fonts & Docs . . . continued from page 1

sizes, you have a problem.
Here�s how you install a printer:

1. From the Main menu, select Utilities / Install Printer.

2. Select Printer A, B, C, D or E.

3. Select a printer port (usually LPT1 for a standalone PC,
or LPT1, LPT2, and so forth, for a network printer). You
can install several printers to print to the same port.

4. Choose the printer manufacturer from the list (for
example, HP for Hewlett Packard).

5. Select the right combination of printer model,
orientation, and  paper size.

Letter (8.5 x 11-inches) and Legal (8.5 x 14-inches) are
American paper sizes, whereas A4 paper (8.69 x 11.69-
inches) is the standard in the UK and Europe.

When you select a printer, Q&A might display a
panel of information that includes the number of lines per
page (often 64 or 66). This is the setting you should use
for your page length when printing to this printer.

Usually, it isn�t necessary to press F8 to specify Special
Printer Options.  If you do, however, the first of the two
additional screens tells you the font file for the printer. If
you know what you�re doing, you might get away with
using a non-recommended font file, but I don�t advise it.

Here are a few notes about printer installation:

* If you have a Postscript printer, select Apple Laserwriter
no matter the make or model.

• HP LaserJet 5 and 6 printers work well with the HP 4
driver.

• The information Q&A provides varies depending on
the printer you�re installing. In some cases, technical
information on the printer might be required. For
example, Q&A might tell you to configure the printer�s
dip switches a certain way. However, doing this can
affect printing from applications other than Q&A.

• Q&A stores printer drivers in a file named
QAPRINT.CFG in the main program files directory. If
you can�t find the printer model you want to install,
check the date of this file�you might need to obtain a
more up-to-date version from Symantec�s customer
service, its bulletin board, or one of its on-line services.

2.  Installing a font file
Installing a font file makes it available to Q&A. These
files are stored in the Q&A program files directory or a
FONTS subdirectory. You can store font files locally or on
the network. As with all program files, you can improve
performance by having them available on the local PC.

Here are a few of the common font files:

HP Laserjet series II, III HPLASERJ.FNT
HP Laserjet series 4 and later HPLASER4.FNT
HP Deskjet 500 HPDJ500.FNT
Epson LQ series dot matrix EPSONLQ.FNT
Epson Esc-P2 dot matrix EPESCP2.FNT
Most 12-pin basic dot matrix EPSONFX.FNT
Canon LBP-8 lasers CANON8.FNT
Canon LBP-8 series III lasers CAN8III.FNT
All Postscript Lasers POST.FNT (regardless of model)

Some font files are interchangeable. For example
either of the above HP LaserJet font files can be used for
either Laserjet series III or series 4 printers.

If you can�t find the right font file for your printer,
check with Symantec Customer Service or one of
Symantec�s on-line services.

3. Using absolute measurements
When you install Q&A, the default document settings,
regardless of the country or installed printers, are these:

Left margin: 10 Right margin: 68
Top margin: 6 Bottom margin: 6
Page width: 78 Page length: 66

These default settings treat the page as a sheet of graph
paper with rows and columns, each character taking up
one square. This analogy works well if you use only
fixed-pitch (monospaced) fonts. Each character in a fixed-
pitch font is the same width as every other character.

Remember this important rule: Horizontal settings (left
and right margins, and page width) give predictable results
only when using fixed-pitch fonts. Some examples of fixed-
pitch fonts are Courier, Letter Gothic, Pica, Elite, and Line
Printer.

Most fonts found on today�s printers aren�t fixed-
pitch fonts�they�re proportionally-spaced fonts. Examples
of these are Times Roman, CG Times, Dutch, Univers,
Helvetica, Swiss, and Souvenir.

If you use proportionally-spaced fonts, you must use
what are called absolute measurements (inches or
centimeters) for your horizontal settings. You can use
either lines or absolute measurements for your vertical
settings.

Don�t expect Q&A for DOS to print TrueType fonts.
These are soft fonts designed to be printed only by
Windows programs. Examples of these are Times New
Roman, Arial, and Wingdings. To print fonts that aren�t
built into your printer, you�ll need to purchase a font
cartridge or soft fonts. (See Roger Skidmore�s article on
using soft fonts in the March 1995 issue of The Quick
Answer.)

Page width and left/right margin settings
It surprises many Q&A users to find out that the Define
Page screen is not the place to specify paper size.
Remember, you did that when you installed your printer
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driver. In order to work out the appropriate settings for
page width and margins, you need to know your
printer�s unprintable region. This is the band around the
edge of the page where the printer can�t print. When
using absolute measurements (inches, for example) you
need to take this unprintable region into account. (Your
printer�s manual will tell you what it is.)

In general, the following rules apply:

• Page width equals the actual paper width minus two
times the unprintable region.

• Left margin equals the desired left margin minus the
unprintable region.

• Right margin equals the desired right margin minus the
unprintable region.

An HP LaserJet has an unprintable top and bottom
region of .5-inch, and an unprintable left and right region
of .25-inch. When using US letter paper, this means:

Page width = 8.5" - (2 x 0.25") = 8.0"
Left / right margins = 1" - 0.25" = 0.75"

For European A4 paper, it means:

Page width = 8.27" - (2 x 0.25") = 7.77"
Left / right margin = 1" - 0.25" = 0.75"

Note that the left and right margin settings are
measured differently depending on which method you
use. The default settings of 10 and 68, for example, are
both measured from the left edge of the sheet of paper.
When using absolute measurements, the left and right
margins are measured from the respective edges of the
paper. (All Windows word processors use this latter
measurement system.)

Vertical dimensions
Specifying absolute measurements for vertical
dimensions isn�t strictly necessary. You can specify lines,
using the formula of six lines to an inch. But either way
you still have to take into account the printer�s
unprintable region. Using US Letter paper, for example,
you can calculate your vertical measurements this way:

Page length = 11" - (2 x 0.5") = 10"
Top / bottom margins = 1" - 0.50" = 0.50"

A surprising side-effect occurs when using absolute
measurements for page length: Reducing the page length
increases the line spacing. (Remember that the paper
dimensions are specified with the printer driver.)  If you
set a longer page length, Q&A reduces the line spacing,
while a shorter page length increases the space between
lines. I find that a page length of 10.5-inches looks best

for European A4 paper. The degree of line spacing that
looks best can depend on the font you�re using.
Experiment to find your preferred setting.

The following table shows my suggested Define Page
settings using an HP LaserJet with 1-inch margins all
round:

Letter Legal A4
Page Width 8.0" 8.0" 7.77"
Left margin 0.75" 0.75" 0.75"
Right margin 0.75" 0.75" 0.75"
Page Length (inches) 10.0" 13.0" 10.5"
Page Length (lines) 60 72 64
Top/bottom margins (inches) 0.50" 0.50" 0.50"
Top/bottom margins (lines) 3 3 3

4. Using Real tab characters
When aligning text in columns with proportionally-
spaced fonts, using Real tab characters is essential. (Q&A
3.0 doesn�t have real tab characters�it just inserts
spaces.) Unfortunately, Q&A defaults to not using real
tabs�you have to change it.

To turn on the Real tabs option, select Write /
Utilities / Set Global Options / Set Editing Options. At
the Editing Options screen, set Use real tab characters to
Yes, and set Show tabs on screen to Yes. Then press F10 to
save your changes.

Showing tabs on screen lets you readily see, in any
document, whether your text is aligned because of real
tab characters or just spaces.

When using proportionally-spaced fonts, remember
the rule: Never use spaces to align text. Doing so might look
fine on the screen, but the printed output will be a mess.

Existing documents
You might have documents containing aligned columns
that you created when the Real tabs option was off. As
long as the document uses a fixed-pitch font, the columns
stay aligned when the document is printed. If, however,
you apply a proportionally-spaced font to such a
document, the columns won�t align in the output. You�ll
have to manually delete the spaces between the columns
in each affected document, and replace them with one or
more Real tabs. An extra benefit of doing this is that if
you move a tab stop, the whole column will move to it.

5. Assigning fonts
Q&A doesn�t assign fonts to documents by default.
Accordingly, it prints all text using the printer�s default
font, which is usually Courier.

You can assign up to nine fonts to any Write
document�the default font (called the Regular font), and
up to eight alternate fonts you can use throughout that
document. Follow these steps to assign a Regular font to
a Write document:

1. In Write, press Shift-F6 to display the Text
Enhancements and Fonts menu.
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2. Press A for Assign Fonts. This displays the Font
Assignments screen.

3. Select the font file for your printer if one isn�t already
displayed, and press Enter move to the Regular font
field. (This will be the document�s default font.)

4. Press F6 to display a list of available fonts, highlight
one, and press Enter to select it. If the font is scaleable,
Q&A will prompt you to specify a point size (usually
between 10 and 13 for regular body text).

5. Press F10 to return to the document screen.

Here are a few tips for assigning fonts:

• You can press Ctrl-F9 from the document screen to go
directly to the Font Assignments screen.

• A font in Q&A includes a point size, and can include
attributes such as bold, italic or bold/italic. Although
you can apply these attributes using the Bold and Italic
selections on the Text Enhancements and Fonts menu,
you�ll get better output if you use the actual enhanced
version of the font rather than apply an enhancement to
the non-enhanced version of it.

• Instead of pressing F6 to display the list of available
fonts, you can press the Spacebar then press Enter from
a blank field.

• Any Font Assignments screen can be made the default
for all new documents by pressing F8. (See note below.)

• When at the Font Assignments screen for a particular
document, the default Font Assignment screen (if any)
can be copied to the current screen by pressing F5.

• For reports, you can assign fonts at the Column/Sort
Spec, or in the Header/Footer sections of  the Define
Page screen.

• For Print Specs, you can assign fonts at the Fields Spec,
or in the Header/Footer sections of the Define Page
screen.

Important note: Do not set a default font for all
documents if you�re using Q&A 5.0.  There�s a bug in
Q&A 5.0 that can crash your PC if you press F6 to expand
a field at the Retrieve Spec for a mail merge document or
mailing label. This only occurs if a default font has been
specified in Write. There are several workarounds:

• Don�t create new documents from scratch. Instead, use
a �template� document (containing the fonts you use)
to start a new document, then save the new document
to a new filename.

• Create a macro that fills out the Font Assignments
screen for each new document.

• Don�t press F6 to expand a field at the Retrieve Spec of

a mail merge document or mailing label. Increase the
field�s size so you don�t have to expand it, or type the
retrieval parameter into another, larger field, then copy
(F11) and paste (F12) the parameter into the desired
field.

Follow these steps to assign additional fonts to a
document:

1. From the document screen, press Shift-F6 for the Text
Enhancements and Fonts menu.

2.Choose A for Assign Fonts. The Font Assignments
screen appears.

3. Press Enter to move to the Font 1 field, then press F6 to
display the list of available fonts.

4. Highlight a font on the list, and press Enter to select it.

5. If the font is scaleable, Q&A will prompt you to specify
a point size.

6. Repeat steps 3 thorough 5 for each additional font you
want to assign.

7. Press F10 when complete.

Don�t assign more fonts than you need. Too many
can affect performance.

Q&A stores a document�s font assignments in the
document file.

6. Applying Fonts
You must assign fonts to a document before you can
apply them. Applying a font to a portion of text is a block
operation done via the Text Enhancements menu. Follow
these steps to apply an assigned font:

1. Place the cursor at one end of the text to be enhanced.

2. Press  Shift-F6 to display the Text Enhancements and
Fonts menu.

3. Under the default text attributes is a list of up to eight
assigned fonts. If none are assigned, or you don�t see
the one you want, Press A for Assign Fonts, and assign
the font as covered earlier.

4. Select the desired font, and press Enter. (You�ll be
returned to the document screen.)

5. Use any means to select the text to be enhanced (arrow
keys, page down, and so on).

6. Press F10 to apply the font.
Following are some notes on applying fonts.

• Q&A isn�t WYSIWYG. Non-Regular fonts are indicated
on-screen by different colors.

Continues on page 12
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EDITED BY T.J. SHUFLIN

Producing Overall Averages

Is there a way to make a Q&A report calculate an overall
average? Here’s what my data looks like:

  Total Sale     Quantity    Price Each
   $1000.00         100        $10.00
    2500.00         200         12.50
     300.00          50          6.00
  ----------     --------    ----------
   $3800.00         350         ?????

When I tell Q&A to calculate the average for the Price
Each column, I get $9.50, which is the average based on
(10.00 + 12.50 + 6.00)/3. In this case, though, the answer I
need is $10.86, which is 3800.00/350. I can use the formula
@total(total sale)/@total(quantity) in a derived column, but
then Q&A prints the result on every line, which I don’t
want. On the other hand, I can’t use the Print Totals Only
option, because I need to see the detail.

Erika Yoxall, Garrettsville, Ohio

Here are the Column Specs and Derived Columns that
will provide the kind of overall average you�re after.

Item: 10,AS    Price: 40   Quantity: 30,ST,T
Total Sale: 20,ST,T

Derived Columns:

Heading: Repeat Item
Formula: #10
Col. Spec: 100,I

Heading: Average
Formula: @Text(#100<>#10,@Total(#20,#10)/@Total(#30,#10))
Col. Spec: 90,F(N2)

These specs will produce a report like the following. (I�ve
included some additional data to help illustrate.)

 Item   Total Sale   Quantity  Price   Average

--------   ---------------   -----------   --------   ----------
Gloves     $1000.00       100  $10.00    10.86
Gloves      $300.00        50   $6.00
Gloves     $2500.00       200  $12.50
        -----------  --------
Total:     $3800.00       350

Hats       $2500.00       200  $12.50    12.88
Hats        $797.50        55  $14.50
Hats         $50.00         5  $10.00
        -----------  --------
Total:     $3347.50       260
======  ===========  ========  ======  =======
Total:     $7147.50       610

Sorting the data on the Item field (10,AS) lets you use
@Text as a  comparison function to determine (1) when
the Item changes and (2) perform the calculation when
the Repeat Item column (#100) changes. The @Totals are
also calculated on the Total Sale column when there�s a
change in the Item column [@Total(#20,#10)]. The average
is printed just once, although on the first line of each
�group� of items. Notice that the Average column (#90) is
between the Item (#10) and Repeat Item (#100) columns.
This ensures that Q&A performs the calculations in the
right order.

Converting Text Dates to True Dates

I have a database with a text field that stores dates. The
field is formatted with a ##/##/## template that
corresponds to a MM/DD/YY date format. I need to convert
it to a true date field in Q&A 4.0’s date format #7 (MM/DD/
YY) so the dates will look the same as before but enable me
to work with them as actual dates. What should I do?

T.M. Lady, New York

The following steps should convert the data properly. Be
sure to backup the database before starting:

1. Remove the template from the field, but leave it as a
text field. To do this, select File / Design a File /
Customize a File / Field Template, clear the template,
then resave the Spec.

2. Mass Update the database. Select File / Mass Update,
and include all the records at the Retrieve Spec. At the
Update Spec, press F6 to expand the field, type this
program, then run the Mass Update:

#1 = @Right(#1,2) + “/” + @Left(#1,2) + “/” + @Mid(#1,3,2)

3. Go to the Format Spec (File / Design a File /
Customize a File / Format Values), and change the field
format from Text to Date. Press F10, and choose Date
Format #7 at the Global Format Options screen.

This procedure will convert all valid dates to the
MM/DD/YY display format you�re after, and you�ll have
a �real� date field you can use to perform date
calculations. Any date that was invalid (improperly
entered) to begin with won�t be properly converted. The
following table illustrates how the dates might look when
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you�ve completed the steps:

Text Field Text Field   Text Field      Date Field
(Template) (No Template)  (Mass Updated) (Format #7)
(MM/DD/YY)

02/05/95     020595         95/02/05       02/05/95
12/11/96     121196         96/12/11       12/11/96
14/05/96     140596   96/14/05       96/14/05
07/34/97     073497         97/07/34       97/07/34
45/67/89     456789         89/45/67       89/45/67

Notice that the last three entries in the final column
contain invalid dates because one or more parts of the
�dates� in the first column were invalid. (A Mass Update
doesn�t give Q&A the opportunity to convert them to a
proper date format or warn you that they can�t be
reformatted to dates). For this reason, you should take
steps to verify that the �dates� are all in proper MM/
DD/YY order before running the conversion procedure.

Query Guide Can Be Useful

I’m at a new job where Q&A is used extensively but no one
is available to help me learn it. What’s the easiest way to
find information in a database?

Tommy Nathan, Las Vegas, Nevada

As you work with Q&A, you�ll learn to use the Retrieve
Spec (Search/Update) to quickly find and display the
database records you need. But to start with, you might
find the Query Guide in Q&A for DOS 4.0 and 5.0 more
intuitive. (Don�t confuse the Query Guide with the
Intelligent Assistant, which is quite different.) Q&A for
Windows� �DAVE� (Do Anything Very Easily) feature is
similar to the Q&A for DOS Query Guide.

The Query Guide offers an easy way to search a
database, as well as perform other common tasks such as
run reports. You can use the Query Guide without
teaching it anything about your database. Or, you can
perform a simple one-step procedure to teach it, making
your searches even easier. Teaching creates indexes for
the fields you�ll most likely want to search. This, in turn,
lets you to pick your search criteria from lists instead of
having to type them. But since this increases the size of
the database�s index (.IDX) file, you might want to check
with the boss to make sure it�s okay to do this.

More on using Q&A 4.0�s Query Guide can be found
in the June 1991 (p.14) issue of The Quick Answer, and in
the March and April 1993 issues. Q&A 5.0�s Query Guide
is essentially the same, if not identical, to Q&A 4.0�s.

Align Objects on Q&A for Windows Forms

When I’m designing a new input form in Q&A for Windows, I
can’t seem to get the fields and field names aligned the
way I want. When I try to move them, they jump to a
different location. What am I doing wrong?

Alice Anderson, Houston, Texas

You probably have the Snap to Grid feature turned on, and
the grid itself hidden, so Q&A is aligning your objects to
a grid you can�t see. When designing an input form in
Q&A for Windows, you can position objects (fields, field
labels, and so forth) by manipulating various alignment
settings. The Arrange menu includes an Align to Grid
command that aligns objects to a grid. To display the
grid, pull down the Format menu and select Rulers and
Grid. You can choose whether to display or hide the grid,
whether you want objects to Snap to Grid (be aligned on
the grid), and the spacing of the grid�s dots.

You can also align objects relative to one another
(such as aligning a group of fields vertically down the
form). This not only makes the form look cleaner and
more pleasing to the eye, but can affect its default tab
order (the order in which Q&A moves the cursor from
field to field). The commands on the Arrange menu will
help you adjust the positions of the objects on the form.
In most cases, one or more objects must be selected
(highlighted) before these commands can be used.

Cure for “Spacey” Labels

When I create mailing labels in Q&A for Windows, I wind up
with gaps between fields on the same line. And if a line
contains just one field that’s blank in the database record,
the label prints with a blank line. Q&A for DOS took care of
all this much better!

Michael Dearborne, St. Louis, Missouri

You�ll need to modify your label design to incorporate
Q&A for Windows� Slide feature. Try this with a sample
label. Pull down the Select menu, then choose Design
Reports/Labels / New Label. Choose the label type from the
drop down list, add your fields, then click OK. Select the
fields you want to �slide� to eliminate gaps or blank
lines, then pull down the Arrange menu, and click Slide
Objects. In the Slide Objects dialog box, you can select
Slide Left and Slide Up to Fill. Do so, then print a few
labels on some regular paper to see the effect.

Tracking Condo Usage

I need a database to track several condo units. It has to
show the starting and ending rental dates, along with the
number of nights each condo was rented. I’m not much for
programming, so I need an easy solution.

Egan Moore, Oklahoma City, Oklahoma

Create a database with the following seven fields:

Field Format Field Format
Condo No Text Counter field Number
Start Date Date Search field Keyword
End Date Date (multiline)
Number of nights Number Work field Date

Continues on page 12
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JOHN DOW

Ever wonder what causes a Q&A
database file to grow, shrink when you
recover it, then grow again as soon as
you do anything to it?

TO understand what determines the size of your
database files, there are a few things you should
know. First, as you add records to a database, Q&A

tries to find existing free space in the file for them. When
the free space is exhausted, Q&A adds more in a fairly
large increment. This way, Q&A doesn�t have to increase
the file size as frequently, and this helps performance. But
the downside is that a database can be considerably
larger than it needs to be.

Virtually any change you make to a .DTF (database)
file requires space. A new report requires space. Editing
records or Specs can require additional space if the
modified items grow too large for the allocated space.

Database file size changes seem to follow these rules:

Rule 1: The file size doesn�t increase until all free space in
the file has been filled.

Rule 2: When more space is needed, Q&A adds an
amount equal to 25% of the file size. Thus, a database
with a file size of 34,816 bytes will suddenly grow by
34,816 / 4 = 8,704, to a new size of 43,520 bytes.

Rule 3: The minimum increment is 7,680 bytes no matter
how small the database file. The maximum increment is
65,536 bytes no matter how large the file.

Field overhead
The second thing you should know is how the number of
fields affects a database�s file size. Every field produces
two bytes of overhead for every record and Spec, even if the
field isn�t used in the Spec and is blank in all the records.

When you add a field, virtually nothing happens to
any Spec or record. But when you do anything to any
saved Spec, it grows by two bytes, even if the new field
isn�t used in the Spec. Thus, if you have 1,000 records and
perform a mass update, the file will require another 2,000
bytes just to accommodate the one field, even though it
might be empty in every record and not part of the Spec.

Suppose a database has 600 fields and 200 reports.
Each report has a Retrieve and Sort Spec. The file size
overhead due to this factor alone is (600 fields) x (200
reports) x (2 bytes per field) x (2 Specs per report) = 600, x
200 x 2 x 2�or 480,000 bytes! If the database has 500
fields and 1,000 records, the overhead for the records is
500 x 1,000 x 2�or a hefty 1M!

Free space
The third thing you should know is that each Spec and
record are likely to contain a little free space. It�s difficult
to predict growth in file size as a result of adding just one
field. However, if you add several fields, you�ll surely see
the file size jump.

Reusing space
The final thing to know is that Q&A doesn�t always reuse
space efficiently on-the-fly. For example, if  a mass update
causes some records to grow beyond their free space,
Q&A seems to allocate space for an entire new copy of
each of these records, leaving the old ones behind for a
future database recovery to remove. Thus, a database can
suddenly grow wildly beyond the predictions made by
the number of fields described earlier.

I added 30 fields to a 3M database containing 1,520
records, then performed a null (empty Update Spec) mass
update on it. I predicted that 30 fields added to each of
the 1,520 records would require about 90,000 more bytes.
I figured that some of that would fit into the free space
available in each of the 1,520 records, but that some of the
records would exceed their free space and cause Q&A to
create new, larger versions of them.

However, after running the null mass update to bring
each record up to the current generation (but adding no
new data), the file size grew by 196,608 bytes. Much of
that was temporary due to the larger versions of some of
the records. A database recovery recouped much of it,
returning the database to a mere 12,000 bytes net growth.
But after I made a minor change to the database, it
jumped the predicted 65,536 bytes, for a total increase of
about 78,000 bytes. Here�s a summary of the results:

Original  size 3,044,864 bytes

Add fields, then 3,241,472 (grew by 196,608)
null mass update

Database recovery 3,057,152 (shrunk by 184,320, net growth: 12,288)

Null redesign 3,122,688 (grew by 65,536)

Remember the overhead. And if you�re concerned
about database file size, keep the number of fields in your
database from getting out of hand.

John Dow is the creator of a variety of Q&A database utility programs,

including DTFDOCTR and DTFSPECS reviewed in The Quick Answer.  412-

521-1577, jtd@pgh.net, or CompuServe at JohnDow.

How Your Database Grows



The Quick Answer  ●  September 1997 9

In this final installment on macros, you’ll record
and run a macro that prints a report. You’ll then
add a pause command to the macro so you can
type in variable information at print time.

You�ve had two months to get acquainted with macros.
Hopefully, by now, they�re not so scary anymore! In this
final installment you�ll use the same sample database you
used in Parts 1 and 2 (ANSMACH.DTF) and create a
macro that prints out your messages in report form.
Then, you�ll  open the macro file in Write, and add a
command to the macro to make it pause for you to enter a
date range (of messages received) before it prints the
report.

Start by loading your test macro file:

1. Go to the Main menu.

2. Press Shift-F2 to display the Macro menu.

3. Select Get Macros.

4. Type the path to your test macro file, such as
C:\QA\MACTEST\QAMACRO.ASC, and press Enter.

To give the report you�re about to create something
to print, add a few dummy records to ANSMACH.DTF,
including a few with today�s date.

Create the report
Now let�s set up a simple ANSMACH.DTF report for the
macro you�ll create later to print.

1. Select Report from the Main menu.

2. Select Design/Redesign a Report.

3. Enter the path to ANSMACH.DTF at the filename
prompt.

4. Name your new report Messages.

5. Leave the Retrieve Spec blank, and press F10.

6. Fill out the Column/Sort Spec as follows:

Message Date: 1,AS
Name:  2
Message: 3,H(Message)

7. Press F10 to continue.

Macros—The Missing
Link, Part 3
ERIKA YOXALL

8. Set any Define Page or Print Options you need.  Be sure
to set Print Preview to No.

9. Press F10 to save the report, and choose Yes to have
Q&A print it. Your Messages report should look
something like this:

Message Date       Name                     Message

------------  --------------  -------------------------------------

07-22-1997    Bob Jones       Can you get me the sales figures for

                              the last quarter? Thanks!

07-31-1997    Michael Jordan  I need some pointers on my jump shot.

                              When are you free?

08-06-1997    Erika Yoxall    Call me when you get back. I have the

                              meeting notes you r equested.

Record the Print Messages macro
When you have the Messages report in good shape,
return to the Main menu and create your new macro:

1. Press Shift-F2 to display the Macro menu.

2. Choose Define Macro.

3. A message will appear at the bottom of the screen
asking you to assign a macro identifier to this macro.
Press Alt-R. (A flashing square will appear at the lower
right corner of the screen to indicate that the recorder is
running. Any keys you now press will be recorded in
the Alt-R macro.)

4. Choose Report from the Main menu by pressing R.
(Press R then Enter if your Q&A menus aren�t set for
Automatic Execution.)

5. Choose Print a Report from the Report Menu by
pressing P. (Press P then Enter if your menus aren�t set
for Automatic Execution.)

6. At the filename prompt, press Home, type the path to
ANSMACH.DTF (C:\QA\MACTEST\ANSMACH for
example), then press Enter.

7. Type Messages at the Enter Name prompt. (When
choosing a report or a saved Spec in a macro, always
type out the name rather than using the arrow keys to
make a selection.)  Press Enter.

8. Press Y to make temporary changes to the report. (Press
Y then Enter if your menus aren�t set for Automatic
Execution.)
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9. Press F10 three times to print the report. Q&A will
return you to the Report menu after printing the report.

10. Press Esc to return to the Main menu.

11. Press Shift-F2 to display the Macro menu.

12. The Macro Name field will show the Alt-R identifier
you assigned.  Type a recognizable name over it (for
example, Print Messages). Leave Show Screen set to
Yes, leave the End with Menu  line blank, and press
F10.

13. Q&A will ask you if you want to save this macro.
Make sure that the macro filename Q&A proposes is
your test macro file, then press Enter.

14. Reload the macro file by performing the steps at the
beginning of this article.

To test your new macro, return to the Main menu and
press Alt-R. Q&A should print your Messages report.

Pausing the macro during playback
The Messages report and the Print Messages macro are
designed to be flexible. You designed the Messages report
with a blank Retrieve Spec so that at print time you can
specify which messages to include.  Adding a wait
command to a macro tells Q&A when to pause so that
you can enter variable information at a prompt or in a
Spec. In this case, you�ll have the macro pause at the
Retrieve Spec for the Messages report so you can specify
a date range of messages to print.

Follow these steps to edit the Print Messages macro:

1. Go to the Q&A Main menu.

2. Select Write, then Get.

3. Type the path to your test macro file, such as
C:\QA\MACTEST\QAMACRO.ASC, and press Enter.

4. Select ASCII. This option might not appear if ASCII is
your default document import type specified at the
Editing Options screen (Write / Utilities / Set Global
Options / Set Editing Options.) The macro should look
like this:

<begdef><altr><name>”Print<sp>Messages”<vidon>RP<home>
C:\QA\MACTEST\ANSMACH<enter>MESSAGES<enter>Y<f10><f10>
<f10><esc><enddef>

5. To add the wait command, place your cursor after the
Y. Make sure you�re in Insert mode, and  type
<wait><enter>.  The <wait> tells Q&A to pause after the
macro �presses� Y to make temporary changes. The
<enter> tells Q&A which key you�ll press to resume the
macro.  The Enter key is the default, but you can
specify any key.  Your macro should now look like this:

<begdef><altr><name>”Print<sp>Messages”<vidon>RP<home>
C:\QA\MACTEST\ANSMACH<enter>MESSAGES<enter>Y<wait><enter>

<f10><f10><f10><esc><enddef>

6. Resave the macro file by pressing Ctrl-F8, then Enter.
Escape to the Main menu, and reload your macro file.

7. Press Alt-R to try your macro again.  This time, it
should pause at the Messages report Retrieve Spec with
the cursor in the Date field. A message will appear at
the bottom of the screen telling you to press Enter to
resume macro playback.

8. Press Ctrl-F5 to insert today�s date, then press Enter.
The macro will resume, and print the report with
today�s messages only.

Notes on using the Wait command
In this example we added the wait command to the
macro in Write. To add a wait command to a macro while
recording it, press Alt-F2 at the point you want the macro
to pause, type any keystrokes, navigate any screens, or
select any commands (these won�t be recorded in the
macro), then press Alt-F2 again to resume recording.

When a running macro is paused, you can enter text,
navigate your screens, or make selections with the
following two exceptions:

• If you press the key that tells Q&A to resume macro
playback, the macro will of course resume.

• If you press the Esc key, you�ll cancel the macro.

This tutorial series only scratched the surface of what
you can accomplish with macros. You can use them to
automate almost any repetitive task, reducing the time
and effort it takes to perform even complex procedures to
one or two keystrokes. For more information on macros,
check out that section in the Q&A Application Programming
Tools Manual. Past issues of The Quick Answer also contain
lots of interesting macro tricks and techniques.

Erika Yoxall owns Hammer Data Systems in Garrettsville, Ohio,

specializing in Q&A and Microsoft Access. Phone/Fax 330-527-4018,

emy103@worldnet.att.net.

Letters
Erika Yoxall rightly points out that you can't record a

macro that exits Q&A (July 1997, page 11).  Here’s a

macro created in Write that I use to exit Q&A:

<begdef><altx><name>"Quit<sp>to<sp>DOS"<vidoff>
<esc><esc><esc><esc><esc><esc><esc>x<enter><enddef>

When I press Alt-X from anywhere in Q&A, the macro

escapes to the Main menu where it presses “X” to exit.

Any unsaved work will cause the macro to fail.

Roger Skidmore, Isle of Wight, UK
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Fonts & Docs . . . continued from page 5

• When the cursor is on text in a non-Regular font, the
font�s abbreviation is shown on the status line at the
bottom of the screen.

• You can�t use Line Draw with proportionally-spaced
fonts. Line Draw can be used only in paragraphs in
fixed-pitch fonts such as Courier. So, you can have a
section of your document in Courier and use Line
Draw in that section. You can also draw horizontal
lines above and below proportionally-spaced text by

putting them in Courier. You can�t, however, use Line
Draw to draw a box around proportionally-spaced text.

Conclusion
Don�t give up on Q&A just because you�re tired of seeing
your documents and reports in boring, old-fashioned
Courier. With Q&A set up correctly, you can take
advantage of the smart, scaleable fonts available in
today�s printers.

Alec Mulvey owns Keyword Consultancy and Training in Ascot, near

London, England. amulvey@compuserve.com

At the Program Spec (File / Design a File / Program
a File / Program Form), type the following programs into
the fields. (Press F6 if you need to expand the field):

Condo No: #5
Start date: >#10: #40=#10
End date: #20
Nights used: <#30: #30=#20-#10; #35=#30; GOTO #35

Counter field: <#35: IF #35 > 1 THEN {#35=#35-1;
#80=#20-#35; #40=#40+”; “+ @RIGHT(#80,5)+”/”+
@MID(#80,3,2); GOTO #35} ELSE GOTO #80

Search field #40
Work field: <#80: if #80=”” then #80=#20

Add a new record to the database for each
reservation (rental). Enter the condo number, then enter
the rental start and end dates. The programming
calculates the number of nights between the two dates,
and fills the Search field with the actual rental dates.

The Nights used field (#30) calculates the number of
nights, and places that number in the Counter field (#35)
as a starting value. The Counter field�s program performs

@Help . . . continued from page 7 a �loop,� reducing the number of nights by one as it adds
each rented date to the Search field. When the Counter
field reaches 1, the loop ends.

At this point the Keyword Search field (#40) contains
the dates the condo will be occupied for this rental. The
ending date isn�t included. (I assume renters check out
during the day, making the unit available that night.)

To find out if a particular condo is reserved on a date,
go to the Retrieve Spec, type the unit number in the
Condo No field, and type the date in the Search field in a
MM/DD/YY format. (For example, type 09/13/97 for
September 13, 1997.) Press F10, and Q&A will display any
record containing that condo number and date. (Be sure
to type the search date with the slashes and any leading
zero for the month and day.)

Although this solution might not provide everything
you need, it gives you an easy way to track usage, and
find out if a condo is reserved on a particular date.

T.J. Shuflin is a forensic chemist and crime lab director in Alexandria,

Louisiana. He served as the National Q&A User Group’s first president in

1991-92, and remains active by maintaining the group’s Web site at

http://www.qaug.com.


